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Agenda, Day 1

• Overview of Abaqus

• Basic use and concepts

• Geometry modelling 

• Assigning materials and properties

• Meshing and elements

• Loads and Boundary conditions

• Submitting analyses

• Viewing results

• Static analysis Workshops

• Vibration mode analysis Workshop



Overview of Abaqus/CAE and 
Abaqus solvers 



What is Abaqus?
Suite of finite element analysis modules
Graphical user interface Abaqus/CAE 
Solvers Abaqus/Standard & Abaqus/Explicit



Overview of Abaqus/CAE

Graphical user interface to create, edit, monitor, diagnose, and visualize 
Abaqus analyses
Supports familiar interactive computer-aided engineering concepts as
• feature-based, parametric modelling
• interactive and scripted operation
• GUI customization

Provides the most complete interface with the Abaqus solver programs 
available.
Uses neutral database files that are machine independent (Windows 
  Linux)
Powerful extensibility & customization
• Python scripting language
• Automate repetitive tasks with macros
• Build customized GUIs



Overview of Abaqus/CAE

• Create the

   part geometry 

   (and regions 

for

   sections, if 

   necessary)

• Position parts for

  initial configuration.

• Split 

   assembly into

   meshable  

   regions and 

   mesh

• Define analysis steps  

  and output requests

• Define materials

• Define additional     

   part regions

• Define and 

   assign sections 

   to parts or 

   regions

• Define contact 

and

   other interactions

   on regions or  

   named sets, and 

   assign them to 

   steps in the 

   analysis history

• Apply loads, 

   BCs, and ICs to 

   regions or 

   named sets; and 

   assign them to 

   steps in the 

   analysis history

• Submit, 

manage,

   and monitor 

   analysis jobs

• Examine 

results

Part Assembly

Step Load

Mesh Visualization

Property

Interaction

Job

Functionality is presented in modules.
Each module contains a logical subset of the 
overall functionality.
Once you understand the presentation of 
one module, you can easily understand the 
presentation of the other modules.



Overview of Abaqus/CAE
Main menu bar

Model/Results 
tree

Viewport

Prompt areaMessage area or 
command line interface

Selected module



Overview of Abaqus/CAE
Model Tree and the Results Tree
• The Model Tree provides you with a graphical overview of your 

model and the objects that it contains.
• The Results Tree is used to display analysis results from 

output databases as well as session-specific data such as X–Y 
plots. 

• Both trees provide shortcuts to much of the functionality of 
the main menu bar, the module toolboxes, and the various 
managers.



What is a model database file (extension .cae)?
• Contains all the information for any number of models.
• Typically contains one model or several related models.
• Only one model database can be opened in Abaqus/CAE at a time.

Overview of Abaqus/CAE
Model database (.cae)

What is a model?
• Contains all the necessary information for an analysis.
• Contains any number of parts and their associated properties.
• Is independent of other models in the model database, unless an instance of 

another model is created in the assembly
• Objects such as parts and materials can be copied between different models 

in the same database: Main menu > Model > Copy Objects
• Contains a single assembly including the associated contact interactions, loads 

and boundary conditions, mesh, and analysis history.



Starting Abaqus/CAE
1. Command line

abaqus cae
Opens most recently installed release of Abaqus/CAE in
current directory
abq2023HF2 cae
Opens specific release of Abaqus/CAE in current directory

2. Windows Start menu
Opens Abaqus/CAE in startup directory set during installation

3. Double-click .cae or .odb file in Windows folder
Opens Abaqus/CAE in current directory

Suggested workflow when starting a new project
• Create a new directory for the project
• Start a command prompt in the new directory and start Abaqus/CAE from the command line
 or Start Abaqus/CAE from Start menu and then select the new directory created for the project
Now all analysis and results files are written in this directory and things stay organized

Otherwise, the default work directory given during installation is used for all files

Select directory (Do not open/go 
into directory)

Option 1

Option 2



Basic use of Abaqus/CAE

View manipulation
Toolbar to control view (pan, zoom, rotate, etc.).
Alternatively, can use a combination of keyboard and mouse actions:

Rotate: [Ctrl]+[Alt]+MB1. (MB = Mouse Button)
Pan:  [Ctrl]+[Alt]+MB2.
Zoom:  [Ctrl]+[Alt]+MB3.

You can reconfigure these combinations to mimic the view manipulation 
command used by other common CAD applications- Main menu: Tools > Options

Selecting entities from main window
Add to selection: [Shift] + MB1
Remove from selection: [Ctrl] + MB1

Example: Selecting faces 
from model in Main 
window



Basic use of Abaqus/CAE
Models can be imported into one database from another
Model data from the imported database is copied into the current database.

E.g., parts, sections, assemblies, materials, loads, BCs, etc.

Analysis job definitions and custom data are not copied

User A User B Master 
Model

=+



Overview of Abaqus/Standard and Abaqus/Explicit

Abaqus/Standard structural analysis types
Static stress/displacement analysis:

• Linear and nonlinear analysis
• Rate-dependent or rate-independent response
• Eigenvalue buckling load prediction

Linear dynamics:
• Natural frequency extraction
• Modal superposition
• Harmonic loading
• Response spectrum analysis
• Random loading

Linear/Nonlinear dynamics:
• Transient dynamics, Implicit time integration

Articulation of an automotive boot seal

Harmonic excitation of a tire



Overview of Abaqus/Standard and Abaqus/Explicit

Other analysis types available in Abaqus/Standard:
• Heat transfer 
• Acoustics
• Mass diffusion 
• Steady-state transport
Multiphysics with Abaqus/Standard:
• Thermal-mechanical analysis
• Structural-acoustic analysis
• Thermal-electrical (Joule heating) analysis
• Linear piezoelectric analysis

traction

braking

free rolling

Steady-state transport: rolling of a tire on a drum

Thermal stresses in an exhaust manifold



Overview of Abaqus/Standard and Abaqus/Explicit

Abaqus/Explicit
Simulates high speed dynamic events such as drop tests.
• Explicit algorithm for updating the mechanical response.
Also, a powerful tool for highly nonlinear quasi-static analyses
• Material plasticity & damage, multiple compilated contacts, large deformations,...
• Annealing is available for multistep forming simulations

Drop test of a cell phoneRolling of a symmetric I-sectionCrimping of terminal



Overview of Abaqus/Standard and Abaqus/Explicit

Multiphysics with Abaqus/Explicit
Thermal-mechanical analysis
• Fully coupled: Explicit algorithms for both the mechanical and 

thermal responses
• Can include adiabatic heating effects
Structural-acoustic analysis
Fluid-structure interaction

Two-stage forging, using ALE—contours of temperature

adiabatic

fully coupled temperature-displacement



Overview of Abaqus/Standard and Abaqus/Explicit

Special features of Abaqus/Explicit: ALE
• Adaptive meshing using ALE techniques allows the robust solution of highly 

nonlinear problems.
• Mesh adaptivity is based on solution variables as well as minimum element 

distortion. 
• Elements concentrate in areas where they are needed. 
• Adaptation is based on boundary curvature.
Special features of Abaqus/Explicit: Coupled Eulerian-Lagrangian (CEL)
• Define a domain in which material can flow for a Eulerian analysis
• Flow problems
• Structural problems with extreme deformation 

Bulk metal forming High speed impact

Eulerian mesh

rod material

High speed impact of copper rod

Fluid drop



Starting the Abaqus solvers
Option 1: Submitting the analysis from Abaqus/CAE 
• From Job manager
• Right mouse button on job in model tree
Option 2: Submitting the analysis from the command line
• Create an input file

• Write input file from Abaqus/CAE and/or edit input file in text editor

• Start a command prompt in the working directory containing the input file
• Issue the start command on the command line, examples below:

abaqus job=input_file_name cpus=8 Uses most recently installed Abaqus release, analysis is run using 8 CPU cores
abq2023hf4 job=jobname input=input_file_name cpus=8 Uses Abaqus release 2023HF4, files are named jobname, input is 

      read from input_file_name, uses 8 CPU cores

• Commonly used command line parameters
datacheck  goes through the input file and writes odb and all data needed by the solver. Does not start the actual calculations. Useful for checking the model
syntaxcheck  goes through the input file and writes the odb file. Useful for checking the model. NOTE: does not require a license
gpus=n  number of graphics cards to use in parallel computing. Note: GPU calculation is not supported for all analysis procedures.

1: Create job

2: Submit job

Model treeJob manager



Abaqus conventions



Abaqus conventions



Abaqus Conventions
Abaqus uses no inherent set of units.

User only inputs numbers and Abaqus works with these

It is the user’s responsibility to use consistent units. Examples:
SI:  kg, m, s   Force: N, Stress: Pa

SI (mm):   ton (103 kg), mm, s    Force: N, Stress: MPa

SI (mm, ms): gram, mm, ms   Force: N, Stress: MPa

Common unit systems and units shown in table below

Common systems of consistent units

Most common, and 
generally recommended

Example: Properties of structural steel in SI (mm):
Density: 7.85e-9  [ton/mm3]
Young’s modulus: 206 000 [MPa]

Used in very short duration events like 
drop tests, shock tests, blast loads

Example: Properties of structural steel in SI (mm, ms):
Density: 7.85e-3  [gram/mm3]
Young’s modulus: 206 000 [MPa]



Abaqus Conventions
For boundary conditions and point loads, the default coordinate system is the rectangular Cartesian system.

Alternative local rectangular, cylindrical, and spherical systems can be defined. 
These local directions do not rotate with the material in large-displacement analyses.

local rectangular 
coordinate system 
with YSYMM boundary 
conditions

Boundary conditions on a skew edge



Abaqus Conventions
Degrees of freedom; DOFs
• Primary solution variable at the nodes
• Available nodal degrees of freedom depend on the element type.
• Each degree of freedom is labeled with a number: 1=x-displacement, 2=y-displacement, 11=temperature, 

etc.

Numbering of displacement DOFs
Numbering is used, for example when 
defining boundary conditions



Elements



Perusyhtälöt
• The studied domain (1D:line, 2D:surface, 3D:volume) is discretized into smaller regions; elements
• The unknown quantities at the nodes are the Degrees of Freedom (DOFs)

– In structural analyses the displacements and in some elments also the rotations
• The displacements at any point within the elements are obtained using the nodal values interpolated using shape functions

– Typically polynomials
– Other quantities like stress and strain are obtained from the displacements

• Prescribed values for selected DOFs ance be given; Boundary conditions
– At a support the displacements can be set to zero, for example

• In addtion to boundary conditions, loads can be applied; force, pressure,...
• A system of equations is formed, from which the values of the unknown DOFs are calculated

element

node

Finite Element Method basics



Structural elements (shells and beams) and solid elements

Geometric representation of a beam element is a line
• Material, Profile cross section, and orientation information is given as parameters
• Cannot describe stress in the thickness or width direction of the beam,
• The beam cross-section does not deform
Geometric representation of a shell element is a surface 
• Material and thickness are given as a parameters
• Cannot describe stress in the thickness direction
• Generally, no deformation in the thickness direction

• Assumptions on the thinning caused by significant plastic strain in forming simulations 
can be made.

Geometric representation of a solid element is a solid cell
• Material is given as parameters
• Can describe the full 3D stress and deformation state

Shell element

Beam element

Solid element



Example: Beam, shell and solid elements comparison

IPE-140 beam loading

Since both the structure and the load are 
symmetrical, symmetry can be utilized and only 

half of the structure is be modeled

4 kN point force in the middle of the span 
at the edge of the top flange

2 kN point force at the edge of the top flange

Symmetry boundary 
conditions

The vertical displacement y of 
the lower flange is fixed at the 

entire width of the flange

The vertical displacement y of the lower flange 
is fixed at the entire width of the flange

The vertical displacement y of the lower flange is 
fixed at the entire width of the flange



Example: Beam, shell and solid elements comparison

Beam Shell Solid
Geometry line surface volume
Cross-section 
parameters

Profile dimensions, direction, 
material thicknesses, material material

Pressure load As line load on the beam elements; 
pressure×flange width [F/L]

As pressure [F/L2] on top 
flange

As pressure [F/L2] on top 
flange

Point force Point force and point moment at the 
end node

Point force at the top flange 
edge node

As pressure at the additional 
region at the flange edge. 
Pressure resultant equals 
point force.

For the load, an additional 
region is defined on the solid 

surface



Example: Beam, shell and solid elements comparison

Vertical displacement is practically the same for all models

In the beam model, only the center line displacement 
and rotation are obtained. The vertical displacement of 

the flange edge should be calculated separately

In the shell and solid model, the displacement caused by the 
torsion of the profile is seen directly as translation



Example: Beam, shell and solid elements comparison

Global stresses are practically the same in all models

The beam model is unable to capture the stress 
concentration caused by the point force at the flange edge.

In the shell and solid models, the stress concentration caused by 
the point force is apparent.



Example: Beam, shell and solid elements comparison

Differences in stress concentration in the shell and solid models

Local rounding between flange and web

Shell SolidShell Solid

There is a 3D stress state near the force acting on the 
flange, which can only be captured using a solid model

Local rounding

Local details can only be 
analyzed using a solid model



Example: Beam, shell and solid elements comparison

Required computing resources
• Beam model: 1 second with one processor
• Shell model: 2 seconds with one processor
• Solid model: 173 seconds with three processors
Results summary
Global phenomena, e.g., bending and stress for the whole beam
• These are already apparent with a very light beam model
Cross-section deformations
• These cannot be calculated using a beam model (1D model)
• Can be calculated with a shell model with cross-section modeling (2D model)
Local phenomena, e.g., stress in rounding or at local load region
• Analysis requires a full 3D model
• Computationally the heaviest by far



Demonstration of 
Abaqus/CAE functionality
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Static analysis of I-profile cantilever beam

• IPE80

– h = 80

– b = 46

– t = 5.2

– s = 3.8

• E = 206 GPa,   = 0.3

• F = 1000 N

• L = 2000 mm

• Use beam elements

This end is 

fixed

F
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Step 1: Create a part

For beam elements

• Modelled geometry: Line/Wire

• Data given by section properties:

– Material

– Profile shape

– Profile Orientation

Part module

Create 

part

Give approximate size of 

drawing canvas

Sketch line

Familiarize yourself with the 

sketching tools by testing

Sketcher options

Modify size of 

drawing canvas

An image can be imported, scaled, and set 

on the background of the canvas. This can 

help in modelling complex shapes: take a 

photo, set is as background image, and 

draw lines according to the photo
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Step 2: Create material, profile, and beam section

Elastic material, Units SI (mm)

Profile

Material

1:

2:

3:

Section

Select the previously defined 

profile and material

Note: If Material or Profile 

was not created earlier, short 

cuts are available here

Beam axis 1 direction will 

be used to define beam 

orientation on next slide

Property module
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Step 3: Assign beam orientation

Assign section

1.1: Pick line representing beams geometry

1.2: Optional, Create a named Set of selected region. 

Helpful, if model has several regions with different 

properties

1:

2: Assign orientation

After section and orientation 

assignments are done, the beam  

profile can be visualized:

Main menu: View > Part Display 

Options

Beam profile visualization

1. Select region (the line representing the beam)

2. Abaqus/CAE shown arrows along beam tangent. Give 

approximate direction for beam cross section axis 1 (see 

profile definition on previous slide for axes 1 and 2 directions)
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Step 4: Create the Assembly

• An “Instance” of a part is created in the assembly

• Multiple instances of the same part can be created

– Part instances can be moved and rotated as needed

– If changes are made to the part; modified dimensions, materials, section properties and 

assignments,... all instances of the part in the assembly are updated

• IMPORTANT: The assembly is what is used in the analysis

– Parts that are not instanced are not considered in the analysis

Assembly module

Create 

Instance

Select 

beam part

Tip 1: After creating instances, check the 

number of instances under Assembly > 

Instances in the model tree. Make sure 

you have not created multiple instances of 

the same part by accident 

Tip 2: Assembly level has it’s own display 

settings. Beam profile rendering in the 

Assembly level modules can be switched 

on from Main menu > View > Assembly 

Display Options
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Step 5: Create analysis step

Analysis step defines what is calculated

Create 

Step

Step module

Accept all defaults

Select SF

Modify the default output request to add output of 

beam section forces SF. This is needed to visualize 

the stress on the beam cross section.
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Step 6: Define loads and boundary conditions

The analysis step defines what is calculated

Create 

Load

Load moduleLoad is applied in Step-1

Create 

Boundary 

conditions

Select the vertex at the 

opposite end of the beam 

compared to the where the 

load is applied.

All displacements and 

rotations are set to zero
Fixed Boundary conditions are applied at this end

Select vertex at the end of the 

beam for the force load
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Step 7: Mesh the part

• The geometry is divided into finite elements for the calculation

Tip 1: When you see this error, switch to the Part 

level in the mesh module and try again.

Assign global seed size. This is the approximate 

distance between nodes of the mesh.

The approximate node locations along 

edges are shown in the viewport

1:

2:

Mesh the model

Tip 2: Use Query Information to get the details of the 

mesh.

Info is printed in the message are under the main 

window.

Remember: Student Edition has the limit of 1000 nodes

Mesh module
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Step 8: Create a Job and submit the analysis

Give a name to the job. All 

analysis and output files 

will have this name.

If you have multiple models in 
your .cae database, select the 

one you want to analyse.

Job module

Accept all defaults

Once the Job has been created, it can be submitted for analysis.

Option 1: Right click the Job in the 

Model tree and select Submit

Option 2: Open the Job manager and 

select Submit

Create 

Job
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Step 9: Visualize the results
Check that the job has completed from the Model tree or Job manager

Right click

Visualization module
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Tips for result visualization
Rendering beam profiles and shell thickness

Selecting variable to show in contour plot

Note: Output variable SF must be included 

in outputs to get BEAM_STRESS

Common output variables

U/UR: Displacement (translations/rotations)

S: Stress

E: Linear strain (for linear problems)

LE: Logarithmic strain

RF/RM Reaction forces (force/moment)

CF/CM: Concentrated loads (force/moment)

SF/SM: Beam section forces (force/moment)

Vector or Tensor component or 

scalar (magnitude, equivalent 

stress,.. etc.) is selected here.
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Tips for result visualization

• For solid elements visualization is trivial: Result value at each point is unambiguous

• For shell elements the result value can be from various locations in the thickness of the shell

• For beam elements the result value can be from various locations of the profile cross section

 

Example of beam element output. Location of 

stress visualized by colours is given in the 

legend. Note that the Mises stress in each cross 

section is constant because the Lower flange 

left corner value is plotted for the whole 

visualized cross section.

Exception: BEAM_STRESS output plots the 

stress correctly across the beam cross section. 

However, this output variable is valid only for 

linear elastic material. Do not use with plasticity.

Location in the shell thickness direction or the position in beam 

cross section used for output is selected from Main menu > 

Result > Section Points
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Static analysis of U-profile cantilever beam

U-profile 60x140x6

L = 2000 mm

E = 206 GPa,   = 0.3

F = 1000 N

This end is 

fixed

F

meshed using linear 

shell elements S4R
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Step 1: Create a shell part

• This time shell elements are used to model the beam

– The cross section is modelled as geometry

– Material and thickness are given as section properties

Create part with 

base feature Shell, 

Extrusion

Cross section for 

extruded shell. 

Note: Dimensions 

correspond to the 

middle surface of the 

profile cross section. 

Outer dimensions: 

60x140x6

After sketching, exit the sketcher and 

give 2000 for the extrusion depth.
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Step 2: Create and assign section

Create a shell section

Shell thickness

Material (Created earlier)

Sketch of cross section was done using the middle surface dimensions, so 

Middle surface is selected. Optionally the thickness can be offset with 

reference to the modelled geometrical surface

Tip: After Section assignment the shell thickness can be visualized:

Main menu > Part Display Options > Render Shell Thickness
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Next steps

• Similarly, as in the first example:

– Create the assembly

– Create an analysis step (Static, General)

– Apply loads and boundary conditions

– Mesh the part

– Create an analysis job

– Submit the analysis

Fixed boundary conditions at the 

other end of the beam
Concentrated force at one end of 

the beam
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Agenda day 2

• Geometric nonlinearity

• Material nonlinearity

• Constraints and contacts

• Nonlinear static analysis Workshops

• Dynamic analysis Workshop
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Linear and non-linear problems

• Properties of the linear problem

– Load scaling

– Calculated result U (can be displacement, stress,...) due to load F

– If load F is increased to nF, the result U will be nU

– Load superposition

– Load F1 causes result U1

– Load F2 causes result U2

– If loads F1 and F2 act at the same time, the result U = U1 + U2

– The final state is independent of the loading order.

– If the load F1 is applied first and then the load F2, the result U will be the same as in the 

case when first load F2 and then load F1 would be applied.

• If the problem in non-linear the above-mentioned statements generally do not hold true.
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Linear and non-linear problems

• The most common causes of non-linearity in structural analysis:

– Large displacements; geometric non-linearity

– Non-linear material behavior; material non-linearity

– Plasticity

– Hyperelasticity

– Material damage model

– Contact

– Opening and closing of contact

– Change in the friction contact state: slip/stick

– Non-linear connectors

– Non-linear springs

– Locking/opening/damage connectors



© 2023 Rand Simulation Oy

Geometric nonlinearity

Some examples of geometric non-linearity:

• Effect on load carrying mechanism

– Shell begins to carry load in the membrane mode

– Directions of support forces change (rope)

• Effect on loading

– Change of load orientation or length of moment arm

– crank mechanism

– Surface area of pressure load changes

– inflating a balloon



© 2023 Rand Simulation Oy

Geometric nonlinearity

When must geometric nonlinearity be considered?

• A rule of thumb: If the deformation is not visible by naked eye, there is likely no need to consider 

geometric nonlinearity.

• Some cases cannot be calculated without considering the geometric nonlinearity.

– For example, a rope loaded in a transverse direction.
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Geometric nonlinearity

• Example: rope, which has no bending stiffness 

– Carries only tension force in the longitudinal direction

– Rope force N

F

F

N NF
NN

Free body diagram

In the initial state, when the rope is straight, 

there is no solution for the equilibrium problem.

The equilibrium is found only, when the rope force N gets the 

vertical component at the support points due to deformation.
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Geometric nonlinearity: Example

• Steel plate loaded on one side by evenly distributed pressure

– dimensions: 600 mm x 400 mm

– thickness: 1 mm

– material: E = 200 GPa 

x

yz

Displacement in z 

direction is set to 

zero along all edges

Displacement at the center point is 

analysed

Displacements in xy plane 

constrained at 3 corners only 

to fix rigid body motions
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Geometric nonlinearity: Example

Loading 100 Pa 

Non-linear Linear

Displacement [mm]
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Geometric nonlinearity: Example

Non-linear Linear

Stress [MPa]Loading 100 Pa 
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Geometric nonlinearity: Example

Loading 25850 Pa = 0.2585 bar

Non-linear Linear

Stress[MPa]
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Geometric nonlinearity: Example

Displacement of the center point

Geometrical non-linearity begins to be 

apparent at pressure of ca. 2 kPa

The result of pressure load 10 kPa (0.1 bar) are 

already completely different: 11 mm vs. 110 mm
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Geometric nonlinearity: Example

• Question: What causes this big difference?

• Answer: As the displacement increases, the plate begins 

to carry in the membrane mode.

 

x

yz

SF1 = membrane force in plate [N/mm] in direction x

Colors are only decimal noise, magnitudes 

1.e-13 to 1.e-15.

In the linear model, the membrane force is not 

generated. It is generated only from the 

geometrical non-linearity. 
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Geometric nonlinearity

Computing time

• In a linear problem the system of equations is solved only once

• Geometrically non-linear analysis requires iteration

– The system of equations is solved in each iteration

– Thus, each iteration cycle corresponds to roughly one linear analysis

– Geometrically non-linear analysis computing time   2 - 100 times the linear analysis

– If there are other nonlinearities, e.g., contact, yielding material, the counting time will 

increase even more

– Iterations for material model equations and contact forces
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Displacement of the plate center point and required iterations

Geometric nonlinearity
• Example of iteration history of the plate analysis involving only 

geometric nonlinearity

SUMMARY OF JOB INFORMATION: STEP  INC ATT SEVERE EQUIL TOTAL  TOTAL      STEP       

INC OF       DOF    IF

               DISCON ITERS ITERS  TIME/    TIME/LPF    TIME/LPF    MONITOR RIKS

               ITERS               FREQ

   1     1   1     0     4     4  0.00100    0.00100    0.001000  

   1     2   1     0     3     3  0.00200    0.00200    0.001000  

   1     3   1     0     3     3  0.00350    0.00350    0.001500  

   1     4   1     0     3     3  0.00575    0.00575    0.002250  

   1     5   1     0     3     3  0.00913    0.00913    0.003375  

   1     6   1     0     3     3  0.0142     0.0142     0.005063  

   1     7   1     0     3     3  0.0218     0.0218     0.007594  

   1     8   1     0     3     3  0.0332     0.0332     0.01139   

   1     9   1     0     3     3  0.0503     0.0503     0.01709   

   1    10   1     0     3     3  0.0759     0.0759     0.02563   

   1    11   1     0     3     3  0.114      0.114      0.03844   

   1    12   1     0     3     3  0.172      0.172      0.05767   

   1    13   1     0     4     4  0.258      0.258      0.08650   

   1    14   1     0     4     4  0.388      0.388      0.1297    

   1    15   1     0     4     4  0.583      0.583      0.1946    

   1    16   1     0     4     4  0.875      0.875      0.2919    

   1    17   1     0     3     3  1.00       1.00       0.1252    

                          

 THE ANALYSIS HAS COMPLETED SUCCESSFULLY

Number of iterations

Time instant of the analysis

16

28

41

49

56
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Material nonlinearity

• Plastic material (more details later)

– When the yield limit is exceeded, permanent deformations arise

– Scope of the linear analysis: yield limit is not exceeded 

• Large strains

– Elastic strains are so large that the linear material model is not realistic

– Elastomers, plastic materials, rubber

– Scope of the linear analysis: maximum strain ca. 5%
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Material nonlinearity

• Damage models

– The yield limit and the elastic stiffness change

– E.g., concrete, figures below

– Damage cannot be modeled by linear models Reinforced concrete structure

- Reinforced elastic-plastic model

- Elastic-plastic concrete damage model
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Plasticity

• When the load is high enough, permanent deformation begins to occur in the material

– The deformation will not disappear even if the load is removed

• For metals von Mises plasticity (J2-theory) is most commonly used

• Use in Abaqus:

– The program is provided with a stress-strain relation, obtained from a tensile test

– Abaqus calculates the stresses, and based on them, the equivalent von Mises stresses

– If the yield limit is exceeded, the program iterates until the stress is obtained at the yield limit

– Iteration: Searching for a deformation state at which the stress is at most at the yield 

limit and the structure in balance

– Iterations always increase the computational cost

– From the calculation effort point of view, each iteration cycle corresponds to 

approximately one static linear analysis
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Plasticity, hardening

• Hardening: Yield limit grows with plastic deformation

Strain

Stress

Yield limit y0

Yield limit y1

Plastic strain p0

Fracture

Slope of the linear part = 

modulus of elasticity
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Plasticity, hardening

Strain

Stress

yi

-yi

Strain

yi

-(0 - yi)

yi
y0

2yi

Isotropic hardening: 

Tensile yield increases 

also on the compression 

side yield strength

Kinematic hardening: 

If the yield limit 

increases on the 

tension side, it 

decreases on the 

compression side.

Bauschinger efect2y0
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Plastic material, strain rate dependence

• The plastic behavior of structural steel depends on the loading rate *)

– The yield and ultimate strength increase as the load speed 

increases

• Can be added to the model, rate dependent plasticity

– The material parameters are given as a function of the strain

rate

*) Ref.: P.Soroushian, K-B.Choi, Steel 

mechanical properties at different 

strain rates, J. Struct. Eng. 1987, 

113(4):663-672.

Stress

Strain

Low strain rate:

Yield 355 MPa
Plastic region

High strain rate:

Yield 451 MPa

Ultimate strength 571 MPa

Ultimate strength 510 MPa
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Plasticity, usage recommendations

• If the load is monotonous (steadily increasing) or the load direction does not change, then

– At simplest, give only one yield limit y0

– At the simplest, give only one ideal elastic-plastic material, no hardening

– For numerical reasons, it is generally advisable to use a small hardening

– Use isotropic hardening, yield limit is given as a function of plastic strain

– These are easy to calibrate and to implement into the model, computationally light

• When the load is changing (tension-compression) use:

– either kinematic

– or combined isotropic+kinematic hardening

– these are more difficult to calibrate, computationally heavy
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Plasticity, example

• Cantilever beam, material S355 (yield limit 355 MPa, small hardening)

This end is rigidly fixed
Distributed pressure load on the 

top surface
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Plasticity, example

• Calculated with the second-order solid tetra elements (Abaqus C3D10)

• Von Mises [MPa] in the figure.

• Question: Is there something strange?

Answer: The maximum stress somewhere in the model is 704 MPa. 

The material yield limit is 355 MPa.
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Plasticity, example

• Question: Why is the stress higher than the yield limit?

• Answer: The yielding due to bending begins on the surface, however, the material model is 

evaluated at the integration points inside the element. The stress at the integration points has 

maximum value of 355 MPa, but when extrapolated, the stress on the surface becomes too large.

The maximum stress somewhere in the model is 704 MPa. 

The material yield limit is 355 MPa.
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Plasticity, example

• When calculated with linear shell elements S4R and solid tetrahedrons C3D10HS (integration 

points on the surface)

The biggest stress is now on the 

yield limit for both models.

S4R                                                                                             C3D10HS
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Plasticity, example

• The largest plastic equivalent strain: shell 0.53%, solid 0.59%

S4R                                                                                             C3D10HS
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Plasticity, example

• However, even with ordinary solid tetras, the tension result is not as bad as it first appeared

C3D10                                                                                             C3D10HS

The stress upper limit is set to 356 MPa. 

Higher stress shown in black.
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Plasticity, example

• The displacement result is practically the same in all models.

C3D10                                                                                             C3D10HS

Note: deformation scaled by factor 10. 
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Plasticity, example

Number of DOF of the model

– Shell S4R: 630 (computationally by far the lightest)

– Solid model C3D10: 7446

– Solid model C3D10HS: 7840 (computationally the heaviest)

Question 1: Why does the shell element give the stress result correctly?

Answer 1: The shell element has an integration points on the surface where the greatest bending stress is obtained. The 

shell elements are very good in describing yielding in bending. By default, Abaqus uses 5 integration points in the thickness 

direction of the shell.

Question 2: Why do C3D10HS elements have more DOF than the C3D10, even though both models have the same 

number of elements?

Answer 2: The C3D10HS elements incorporate the internal pressure DOF in the calculation. H = Hybrid element



Constraints and contact



Constraints and connector elements

• By default, part instances in assembly do not interact with each other in any way
• The user must specify interactions between the parts using constraints, contacts, or 

elements

Kinematic coupling 

constraint between bolt 

beam end and 

secondary nodes on 

surface of flange

Contact 

interaction 

between 

pipe flanges 

and seal

Example: contacts and constraints in bolted flange joints model

Constraints: 
• remain active the full duration of 

the analysis
• status does not change
Contact: 
• can be activated or deactivated in 

different steps
• status can change during the 

analysis step; open  close, slip   
stick



Constraints

• Constraints are used to model kinematic relationships between points
• These relationships are defined between degrees of freedom in the model
• Constraints are created in the Interaction module



Tie constraints

• Describes a fully constrained contact
• A simple way to bond nodes/surfaces together permanently
• No slippage or separation of contacting nodes/surfaces regardless of loading magnitude

Main type should be Surface, unless 

node-to-node constraint is needed

For Secondary type use

• Surface for more accurate stress output on 

tied surfaces. The constraint is applied in an 

average sense.

• Node region to exactly constrain specific 

nodes



Tie constraints

Shell element thickness and offset are considered by default, but can be excluded if desired

shell thickness

Secondary node tied on shell with 

thickness and offset considered

shell reference 

surface

n

OFFSET = 0

no offset

shell thickness

Shell element node

n

OFFSET = +0.5 (SPOS)

Shell reference surface is the 

top surface



Tie constraints
Use Adjust to bring the secondary nodes exactly to the main surface
• This is especially important when tying solid element surfaces as shown below
The mesh is modified by moving the secondary nodes to the main surface in the beginning of the analysis without 
causing stress

Tie constraint: 
Displacement of secondary node equals the displacement 
of projection point at the main surface:
uxS  =  uxM

uyS =  uyM

Moves to the 

right

Moves to the left

In case of rigid body rotation, the displacements of 
secondary node and the projection point are not equal.
The tie constraint prevents the rigid body rotation and will 
cause unphysical stiffness and stresses *).

projection point on 

main surface

Secondary 

node being tied

Distance 
Main surface

y

x

Rigid body rotation is NOT a problem when one surface 
is based on beam or shell elements with rotational 
degrees of freedom. In these cases, the rotation is 
correctly accounted for.

*) In Abaqus/Standard under certain conditions the rigid body rotation is correctly 

enforced for solid element meshes. Check this from the user documentation if needed.



Tie constraints

By default, Abaqus will constrain the rotational degrees of freedom when they exist on both secondary and main 
surfaces

Note: Use Shell-to-solid coupling to constrain 

shell rotations to a solid element mesh



Rigid bodies

Rigid body is a collection of nodes and elements whose motion is governed by the motion of a single node called a 
reference node
Any part instance  or subregion of a part instance can be declared as a rigid body
Rigid bodies are computationally efficient

• The 3D motion of the rigid body is completely defined by only 6 degrees of freedom
• Deformation and stress calculations are not done for a rigid body

Model a body as rigid if it is much stiffer that the other bodies it will come to contact with. Examples:
• Dies in metal forming simulations
• Massive bodies in impact simulations



Rigid bodies

There are three approaches to geometry definition for rigid bodies
1. Define a rigid body using elements and assign a rigid body constraint; any meshed geometry and shape
2. Define an analytical rigid surface; surface geometry of limited shape
3. Write a subroutine RSUFRU; Abaqus/Standard only, not considered further in this course
A rigid body definition consists of 1 reference node and at most
• 1 element set
• 1 tie node set
• 1 pin node set
• 1 analytical surface
Each rigid body definition must be unique: Multiple rigid bodies cannot share nodes or elements.
 

Recommended approach



Rigid bodies
Approach 1: 
• Create a part and mesh it
• Define a rigid body constraint as shown

1: Select region type

2: Pick region from 
Viewport OR use 
predefined Set

Tie node: Rotation constrained
Pin node: Acts like a hinge

To model inertia correctly in a dynamic analysis, the rigid body reference point must be 
in the centre of mass of the rigid body.  Using this option, Abaqus will automatically 
calculate the location of the rigid body based on the element geometry and properties.

Note: If the rigid body motion is constrained using boundary conditions, then the 
reference point can be anywhere.

3: Select reference point

Same procedure when selecting the  Reference Point

Rigid body mass data is written into the .dat file



Kinematic and Distributing Coupling constraints
A group of coupling nodes is constrained to the motion of a reference node

Select the constraint control point/points

Select the constrained surface/node region 

Only those nodes of the constrained 
surface that fall inside the influence radius 
from each control point are constrained.

Select which DOFs from 
the nodes on the surface 
are constrained



Kinematic and Distributing Coupling constraints

Two types are available
• Kinematic:  Constraints the motion of the coupling nodes rigidly to the motion of the reference 

node
• Distributing:  Applies the constraint in an average sense. The reference node displacement and 

rotation correspond to a weighted-average motion of the coupling nodes

Weighing factor options. Constant and Linear/Quadratic/Cubic 
reduction as a function of distance from the reference node

Continuum distributing: Only forces are applied to coupling nodes
Structural distributing: Forces and moments are applied to coupling nodes

FF

Continuum Structural



Torque from control point is 
transmitted to solid element tube

Coupling constraint example
Cylindrical coordinate system csys-2

Coupling refers to coordinate system csys-2

U1: Radial displacement
U2: Circumferential displacement
U3: Z displacement

Note: As solid elements have no 
rotational displacements,  
selecting or unselecting UR1, 
UR2, UR3 has no effect when 
constrained surface is 
composed of solid elements.

Constraint control 
point
Torque applied here

Coupled surface

Radial and longitudinal 
displacements of constrained 
surface are free to happen

Undeformed shape shown



Shell to solid coupling
Shell to solid coupling is used to attach solid and shell element meshes so that the translation DOFs of 
the solid are coupled to the rotation DOFs of the shell
 

Shell
Solid

1: Select shell edge

2: Select surface or node region from solid

Position tolerance: absolute distance from the 
solid surface within which all shell nodes to be 
included in the coupling must lie. Shell nodes that 
lie outside this tolerance are not coupled to the 
solid surface.

Influence distance: absolute distance from the 
shell edge within which the solid surface node 
must lie to be included in the coupling. Default is 
half of the shell thickness

Bending stiffness correctly modelled



Shell to solid coupling
If a part contains both shell and solid geometry, shell-to-solid coupling constraints are automatically 
created along the shell-solid interfaces during meshing

Solid cell
Shell face

• Default settings are used for Position Tolerance 
and Influence Distance

• The constraint is internally generated and does 
not show in the Constraint manager

 



Contact interactions
• Contacts are used to model interactions between surfaces or nodes
• Contact status can change during the analysis depending on external loads

• In the normal direction the contact can open or close
• In the tangential direction the contact can slip or stick

Contact 
interactions

Contact 
interaction 
refers to an 
Interaction 
property. See 
next slide.



Contact interactions
• Abaqus has two ways of defining contact interactions

1. Contact pairs
• Traditional way of defining contact
• User selects and creates contact pairs of all surfaces that are likely to be in contact during the 

analysis
• Can result in a more efficient analysis since contact interactions are limited in scope

2. General contact
• Automated creation of contacts inside Abaqus
• Possibility for user to manually include or exclude surface pairs
• Generally, the preferred method

• The choice between general contact and contact pairs is largely a trade-off between ease of 
contact definitions and analysis performance
• Accuracy and robustness of both methods is similar
• Both can be used together in  the same analysis



Contact interaction properties
• Contact interaction definition requires contact properties

Properties in normal direction Properties in tangential direction
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Workshop; Contacting beams

• Use a shell element model

• Dimensions [mm], L x W x t = 400 x 20 x 1

• E = 200 000 MPa,  = 0.3

• Pressure load on top beam: 0.001 MPa

• Frictionless contact

40 mm

40 mm

p = 0.001 MPa 

Sketch of planar shell
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Workshop; Contacting beams

• Use a shell element model

• Dimensions [mm], L x W x t = 400 x 20 x 1

• E = 200 000 MPa,  = 0.3

• Pressure load on top beam: 0.001 MPa

• Interaction properties for contact, see below.

40 mm

40 mm

p = 0.001 MPa 

Sketch of planar shell

Tangential behaviour: 

Frictionless

Secondary surface: End edge of 

topmost beam

Main surface: Top surface of lower 

beam

Default normal behaviour

Best option for 

edge-to-surface 

type contact
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Steps

• Create a shell part. Two options for base feature

– Planar shell

– Extruded shell

• Create material and shell section

• Assign shell section

• Mesh part

• Create two instances of the same part in the Assembly

– Both beams are identical, so no need to define two identical parts. Instead, two instances of the 

same part are created in the assembly

• Position the two beams using the Translate Instance tool
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• Create an analysis step: Static, General 

• In the Interaction module create a Contact property and Contact interaction as shown 

on the previous slide

– By default, parts in the assembly do not interact with each other in any way

– The analyst must define contacts or constraints between the parts

Steps, continued

Switch on Nonlinear geometry, as 

large displacements are expected

Reduce the initial time 

increment to 0.1

In static analysis time does not have a physical meaning. 

It is used to increment the loads and describe the order in 

which thing happen.

The time period of the step is set to 1. The initial 

increment is set to 0.1. This means, that Abaqus will try 

to apply 10% of the load and find an equilibrium state for 

the structure. After this Abaqus increases the load and 

again finds an equilibrium state. This process is repeated 

until the full load has been applied.

The incrementation of the load is automatically adjusted 

by Abaqus based on the convergence history.
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Steps, continued

• Create an analysis Job and submit the analysis

• Check the results

The iteration process and 

convergence history can be 

monitored

Step time=1  Step completed

Time/Load 

increment taken by 

Abaqus

Number of iterations 

needed to find 

equilibrium for increment

U = Unsuccessful. 

Increment aborted and 

attempted again using 

smaller increment

Displacements of contacting beams
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• Plasticity data are entered using true stress and 

logarithmic plastic strain.

• If necessary, convert nominal strain to log strain using 

the equation (1) given on the right

• When a material has incompressible behavior (as is the 

case for rubber and most metals when they deform 

plastically), the relationship between “true” stress and 

nominal stress is given by equation (2) on the right

• Use the following relation to determine the log plastic 

strain:

Material plasticity

1

.pl el E    = − = −

nom .ln(1 ) = +

Log strain Nominal strain

.(1 )nom nom  = +

True stress Nominal stress Nominal strain

plastic strain at initial yield is zero

Slope = E

 pl 

(1)

(2)
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Material plasticity

• Adding plasticity to Contacting beams example

Plasticity added into material definition

RELEASE step added

Pressure load deactivated in 

RELEASE step

Due to plasticity, some deformation 

remains after the load is removed.
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General and Linear perturbation steps

• Abaqus has General steps and Linear perturbation steps

• Linear perturbation = small displacements around a base state

– Linear analysis 

– Small displacements

– Only elastic material response considered

– Contact status remains the same as in base state

• Base state:

– Initial state of model, if linear perturbation is the first step of the analysis 

– State at the end of the preceding General step where NLGEOM is on

• Linear perturbation steps do not affect the time history of a sequence of General steps

– Duration of linear perturbation step is 1e-36
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General and Linear perturbation steps

• Example: Vibration modes of tensioned string

• Sequence of steps

Density: 7.85E-9  Ton/mm**3

E: 200 000 MPa

Length: 500 mm

Diameter: 0.1 mm

Tension: 1 N & 2 N

Element type: B23

Apply tension 1 N

Apply tension 2 N

Calculate eigenmodes

Calculate eigenmodes

Applied force

Ux & Uy fixed

Analytical: 180.11

Analytical: 127.36

1st vibration mode with 1 N tension

1st vibration mode with 2 N tension

Uy fixed
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Where to find more information?

• Abaqus Example Problems, Verification, and Benchmarks in documentation

– Input files and other input data for all examples are available

– Example:

Open and copy/paste to text file or use Abaqus fetch utility:

abaqus fetch job=boltpipeflange_axi_solidgask.inp

https://help.3ds.com/2020/English/DSSIMULIA_Established/SIMACAEEXARefMap/simaexa-c-
boltpipeflange.htm?contextscope=all&id=f88c0b11fa174c71b902ec0a53859db4

https://help.3ds.com/2020/English/DSSIMULIA_Established/SIMACAEEXARefMap/simaexa-c-boltpipeflange.htm?contextscope=all&id=f88c0b11fa174c71b902ec0a53859db4
https://help.3ds.com/2020/English/DSSIMULIA_Established/SIMACAEEXARefMap/simaexa-c-boltpipeflange.htm?contextscope=all&id=f88c0b11fa174c71b902ec0a53859db4


© 2023 Rand Simulation Oy

Where to find more information?

Dassault e-seminars

Technical presentations, New features, Applications

https://events.3ds.com/  E-Seminars

https://events.3ds.com/
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Thank you!

http://www.rand.fi/
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